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МОДЕЛИРОВАНИЕ РАБОТЫ НЕЧЕТКОГО РЕГУЛЯТОРА С 

ОДНИМ ВХОДОМ СРЕДСТВАМИ MATLAB И ЕГО 

РАСШИРЕНИЯ FUZZY LOGIC DESIGNER 

 

Цели работы:   
1. построение нечеткого регулятора с одним входом 

средствами расширения математического пакета MATLAB 
- Fuzzy Logic Designer; 

2. интеграция созданного нечеткого регулятора в модель, 

созданную в среде Simulink; 
3. совместное использование средств SimMechanics и Fuzzy 

Logic Toolbox; 

4. изучение работы нечеткого регулятора с одним входом, на 
примере системы управления подводным роботом, 

осуществляющим горизонтальное перемещение. 

Объект исследования: нечеткий регулятор, реализованный 
средствами Fuzzy Logic Designer – расширения математического 

пакета MATLAB. 

Аппаратные средства: программный комплекс MATLAB, среда 
моделирования Simulink, расширение Fuzzy Logic Designer. 

 

1. Краткие теоретические сведения 

 

Нечеткий регулятор (в англоязычной литературе fuzzy 

controller) является элементом систем автоматического управления, 
использующим принципы нечеткой логики (в англоязычной 

литературе fuzzy logic). Нечеткий регулятор может иметь более 

одного входа. В рамках данной работы рассмотрим нечеткий 
регулятор с одним входом. 

В своих работах, посвященных нечеткой логике, Лотфи Заде 

предложил использование логических правил для задания 
поведения нечеткого регулятора. Форма записи правил для 

нечеткого регулятора с одним входом выглядит следующим 

образом: 
 

ЕСЛИ (условие №1) ТО (действие №1)  

ЕСЛИ (условие №2) ТО (действие №2)  
ЕСЛИ (условие №3) ТО (действие №3)  

… 
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ЕСЛИ (условие №N) ТО (действие №N)  

 

Составление набора правил является важной часть процесса 
проектирования регулятора. Рассмотрим процесс составления 

набора правил на примере задачи разработки регулятора для 

системы управления подводного робота, осуществляющего 
горизонтальное перемещение. Управляемым параметром является 

положение робота. Управление производится по ошибке – разнице 

между задающим воздействием и сигналом в цепи обратной связи. 
Общий вид схемы системы управления показан на рисунке 1. 

 

 
Рисунок 1 Схема системы автоматического управления 

 
Для достижения поставленных задач будем использовать 

следующий набор правил: 

 

ЕСЛИ оставшееся расстояние – слишком малое ТО 

двигаться обратно (осуществлять реверс) 

ЕСЛИ оставшееся расстояние – достаточное ТО 
остановиться 

ЕСЛИ оставшееся расстояние – малое ТО двигаться вперед 

ЕСЛИ оставшееся расстояние – большое ТО двигаться 
вперед 

ЕСЛИ оставшееся расстояние – очень большое ТО двигаться 

вперед ускоренно 

 

Следует обратить внимание на то, что правила используют 

лингвистические категории, такие как «низкий», «высокий» и т.п. 
вместо численных значений. 

При подобной настройке нечеткий регулятор будет работать 

следующим образом. Так называемый «четкий» сигнал поступает 
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на вход регулятора. Этот сигнал подается на входные функции 

принадлежности (в англоязычной литературе «antecedent 

membership functions», «antecedents»), определяющие степень 
принадлежности сигнала к одной из лингвистических категорий. В 

нашем случае мы имеет три такие категории – «ошибка низкая», 

«ошибка средняя» и «ошибка высокая». 
Вид функций принадлежности определяется при разработке 

регулятора. Рассмотрим некоторые виды функций принадлежности. 

 

Треугольная функция принадлежности. Выходной сигнал 

функции, как очевидно из еѐ названия, имеет вид треугольника. На 

рисунке 2 показаны выходные сигналы трѐх треугольных функций 
принадлежности. На рисунке 3 показано подключение блоков 

Triangular MF пакета Simulink, моделирующих работу треугольных 
функций принадлежности. 

 
Рисунок 2 Выходной сигнал трѐх треугольных функций 

принадлежности 
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Рисунок 3 Подключение блоков Triangular MF пакета Simulink, 

моделирующих работу треугольных функций принадлежности 
 

Трапецеидальная функция принадлежности. Выходной 

сигнал функции имеет вид трапеции. На рисунке 4 показаны 
выходные сигналы трѐх трапецеидальных функций 

принадлежности. На рисунке 5 показано подключение блоков 

Trapezoidal MF пакета Simulink, моделирующих работу 
трапецеидальных функций принадлежности. 

 

 
Рисунок 4 Выходной сигнал трѐх трапецеидальных функций 

принадлежности 
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Рисунок 5 Подключение блоков Trapezoidal MF пакета Simulink, 

моделирующих работу трапецеидальных функций принадлежности 

 

Гауссова функция принадлежности. Выходной сигнал 
функции имеет вид гауссовой кривой. На рисунке 6 показаны 

выходные сигналы трѐх гауссовых функций принадлежности. На 

рисунке 7 показано подключение блоков Gaussian MF пакета 
Simulink, моделирующих работу гауссовых функций 

принадлежности. 

 

 
Рисунок 6 Выходной сигнал трѐх гауссовых функций 

принадлежности 
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Рисунок 7 Подключение блоков Gaussian MF пакета Simulink, 

моделирующих работу гауссовых функций принадлежности 

 
Сигмоидная функция принадлежности. Выходной сигнал 

функции имеет вид сигмоиды. На рисунке 8 показаны выходные 

сигналы трѐх сигмоидных принадлежности. На рисунке 7 показано 
подключение блоков Sigmoidal MF пакета Simulink, моделирующих 

работу сигмоидных функций принадлежности. 

 

 
Рисунок 8 Выходной сигнал трѐх сигмоидных функций 

принадлежности 
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Рисунок 9 Подключение блоков Sigmoidal MF пакета Simulink, 

моделирующих работу сигмоидных функций принадлежности 
 

На выходе функций принадлежности мы имеем несколько 

сигналов (по одному сигналу на каждую функцию; число сигналов 
должно быть равно числу лингвистических категорий, 

использованных в разработанном наборе правил). Далее данные 

передаются на заключительные функции принадлежности (в 
англоязычной литературе «consequent membership functions»). Эти 

функции могут иметь тот же вид что и входные функции 

принадлежности. Основное отличие работы с ними состоит в том, 
что в случае с заключительными функциями принадлежности нас 

интересует площадь образованной ими фигуры и еѐ центр масс. 

Поступающий на вход такой функции сигнал обрезает еѐ или 
масштабирует еѐ (см. рисунок 10). 

 
Рисунок 10 Сигнал, поступивший на вход заключительной функции 
принадлежности, обрезает еѐ верхнюю часть; площадь и центр масс 

полученной фигуры являются выходными параметрами функции 
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Следующим и заключительным этапом обработки сигналов в 

нечетком регуляторе является дефаззификация. На этом этапе все 
полученные на прошлом этапе фигуры складываются и 

определяется их общий центр масс (см. рисунок 11) 

 
Рисунок 11 Сложение сигналов, нахождение центра масс 

 

2. Методика выполнения лабораторной работы 

 

Для выполнения лабораторной работы требуется разработать 
структуру нечеткого регулятора и интегрировать регулятор в 

систему управления подводным роботом, осуществляющим 

горизонтальное перемещение. 
Динамику робота, при перемещении вдоль горизонтально оси, 

можно описать следующими уравнениями: 









CF

Fxxm




.     (1) 

где x  - положение робота, m  - масса робота,   - коэффициент 

лобового сопротивления, F  - сила тяги, создаваемая гребным 

винтом,   - угловая скорость гребного винта, C  - коэффициент, 

связывающий скорость вращения винта и создаваемую им тягу. 

 
Модель системы автоматического управления, построенная в 

среде Simulink показана на рисунке 12. 
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Рисунок 12 Модель системы автоматического управления 
 

2.1 Модель робота созданная с применением средств 

SimMechanics 
 

Модель робота реализована средствами SimMechanics – 

набора инструментов, доступного при использовании Simulink. 
Модель робота содержится в подсистеме Robot. На рисунке 13 

показано содержание этой подсистемы.  
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Рисунок 13 Подсистема Robot, содержащая модель робота, 

построенную с привлечением средств SimMechanics 

 
Входным параметром для подсистем Robot является 

суммарная сила, приложенная к роботу. выходными – положение и 

скорость робота. Указанная модель использует блоки SimMechanics 
Second Generation, которые можно найти в библиотеке Simulink, как 

это показано на рисунке 14. 

 



 13 

   
Рисунок 14 Расположение использованных блоков SimMechanics 

Second Generation в библиотеке Simulink 

 
Часть использованных блоков относится к набору Simscape, 

частью которого является SimMechanics. Расположение этих блоков 

в библиотеке приведено на рисунке 15. 
 

 
Рисунок 15 Расположение использованных блоков Simscape в 

библиотеке Simulink 
 

Блоки Solid, Prismatic Joint, и Mechanism Configuration 

требуют настройки. На рисунках 16 и 17 показаны использованные 
настройки блоков. Настройка блока Solid заключается в указании 

массы робота. Настройка блока Prismatic Joint заключается в 

определении его входов и выходов (входом является сумма 
внешних сил, выходами положение и скорость робота). Настройка 

блока Mechanism Configuration заключается в указании величины и 
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направления ускорения свободного падения. В данном случае нас 

интересует движение в плоскости, перпендикулярной линиям 

гравитационного поля, поэтому можем указать нулевую величину 
ускорения свободного падения. 

 

 
Рисунок 16 Настройки блока Solid 

 

  
Рисунок 17 Настройки блоков Prismatic Joint, и Mechanism 

Configuration 
 

Отметим, что сила сопротивления жидкости моделируется как 

пропоруиональная скорости робота, с помощью блока Gain. 
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2.2 Разработка и настройка нечеткого регулятора 
 

Для создания нечеткого регулятора вопспользуемся 
расширением MATLAB - Fuzzy Logic Designer. 

Для вызова приложения Fuzzy Logic Designer используется 

команда fuzzyLogicDesigner: 
 

Листинг 1 Вызов приложения Fuzzy Logic Designer 

 
 

После выполнения команды fuzzyLogicDesigner появляется 

окно, показанное на рисунке 18. 

 

 

Рисунок 18 Окно приложения Fuzzy Logic Designer 
 

 

По умолчанию приложение генерирует регулятор с одним 
входом input1 и одним выходом output1. Переименуем вход и 

выход в DistanceLeft, а выход в Speed. Результат показан на рисунке 
19. 
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Рисунок 19 Окно приложения Fuzzy Logic Designer; вход и выход 

переименованы 
 

Дважды кликнув на вход откроем окно редактирования 

функций принадлежности. Отредактируем эти функции так, как 
показано на рисунке 20. 

 

   
Рисунок 20 Настройка функций принадлежности 

 

Обратим внимание, что для выхода были выбраны Гауссовы 
функции принадлежности, а для входа – треугольные. Менять тип 

функции можно используя выпадающий список Type. Гауссовым 

функциям принадлежности соответствует тип gbellmf, а 
треугольным – trimf. Каждую функцию принадлежности следует 

переименовать в соответствии с еѐ физическим смыслом. 
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Следующим шагом является запись набора нечетких правил. 

Используемый набор правил был приведен ранее. Результат записи 

набора правил показан на рисунке 21. 
 

 

Рисунок 21 Набор нечетких правил 

 

Работу нечеткого регулятора хорошо иллюстрирует 
поверхность отклика. Приложение Fuzzy Logic Designer имеет 

встроенный инструмент построения таких поверхностей. Для 

вызова данного инструмента следует кликнуть на пункт главного 
меню View->Surface, или нажать Ctrl+6. В рассматриваемом случае 

поверхность отклика представляет собой график, показывающий 

связь между входными и выходными величинами разработанного 
нечеткого регулятора. В случае, если бы регулятор имел более 

одного входа, поверхность отклика задавалась бы действительной 

функцией двух переменных, т.е. поверхностью в трехмерном 
пространстве, с чем и связано название «поверхность отклика». 

Внешний вид полученного графика показан на рисунке 22.  
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Рисунок 22 График, показывающий связь между входными и 

выходными величинами разработанного нечеткого регулятора 

 
Приложение Fuzzy Logic Designer позволяет провести анализ 

влияния отдельных функций принадлежности на работу системы. 

Для этого используется Rule Viewer. Для того, чтобы вызвать окно 
Rule Viewer нужно кликнуть на пункт главного меню View->Rules, 

или нажать Ctrl+5. В открывшемся окне можно перемещать линию, 

моделирующую входное значение регулятора, задавая тем самым 
различные входные величины. Rule Viewer графически изображает 

разработанные для данного регулятора входные функции 
принадлежности. Те из них, в которые попадает данный входной 

сигнал, будут подсвечены. Для каждого входного сигнала показано 

как он влияет на работу выходных функция принадлежности, а 
также показан найденный центр масс выходных функций – 

выходное значение регулятора. Внешний вид окна Rule Viewer 

показан на рисунке 23. 
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Рисунок 23 Внешний вид окна Rule Viewer при имитации 

различных входных сигналов  

 

Для того, чтобы сохранить созданный нечеткий регулятор 
нужно кликнуть на пункт главного меню File->Export->To File, или 

нажать Ctrl+S. Можно сохранить регулятор в переменную, которая 

будет доступна в приложениях MATLAB, для этого нужно 
кликнуть на пункт главного меню File->Workspace->To File, или 

нажать Ctrl+T. Данная переменная будет удалена после окончания 

работы MATLAB, или после принудительной очистки памяти 
(например командой clear). 

Для того, чтобы загрузить ранее созданный нечеткий 

регулятор нужно кликнуть на пункт главного меню File->Import-
>From File, или нажать Ctrl+O. 

 

Для того, чтобы использовать созданный регулятор в среде 
Simulink, требуется использовать блок Fuzzy Logic Controller. на 

рисунке 24 показано расположение этого блока в библиотеке 

Simulink. 
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Рисунок 24 Расположение блока Fuzzy Logic Controller в 

библиотеке Simulink 

 
Блок Fuzzy Logic Controller требует указать имя файла из 

которого будет считан нечеткий регулятор, или имя переменной 

содержащей этот регулятор. Здесь будем использовать второй 
способ. На рисунке 25 показаны настройки блока Fuzzy Logic 

Controller. 

 

 
Рисунок 25 Настройки блока Fuzzy Logic Controller 

 
Для того, чтобы создать переменную FLcontroller, которая 

будет использована блоком Fuzzy Logic Controller, выполним 

следующий скрипт (см. рисунок 26). Данный скрипт устанавливает 
значения всех использованных в данной работе переменных. 

 

 
Рисунок 26 Скрипт, задающий переменную FLcontroller 

 

Такой способ работы с блоком Fuzzy Logic Controller оправдан 

тем, что это позволяет динамически модифицировать нечеткий 
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регулятор используя Fuzzy Logic Designer, сохраняя результаты в 

виде переменной, что быстрее чем сохранение в файл. Сохранить 

результаты работы в файл будет необходимо один раз в конце 
сессии работы с Fuzzy Logic Designer. 

Для запуска скрипта требуется нажать на кнопку Run. 

Запустим моделирование созданной Simulink модели, 
отобразим результаты в виде графиков (см. рисунки 27 и 28). 

 

 
Рисунок 27 Временная зависимость положения робота 

 

 
Рисунок 28 Временная зависимость входного сигнала блока Fuzzy 

Logic Controller 
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Рисунок 29 Временная зависимость выходного сигнала блока Fuzzy 

Logic Controller 

 
Для того, чтобы блок Scope отображал графики темными 

тонами на светлом фоне, можно использовать следующие 

настройки блока (см. рисунок 29): 
 

 
Рисунок 29 Настройки отображения графиков в блоке Scope 

 

В случае, если количество точек на графике. отображаемом 
блоком Scope превышает 5000 нужно модифицировать его 

параметры хранения данных, иначе будут построены лишь 

последние 5000 точек. На рисунке 30 показаны соответствующие 
настройки блока Scope. 
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Рисунок 30 Настройки хранения информации в блоке Scope 

 

Численные значения параметров, использованных в данной 
лабораторной работе, приведены в таблице 1. 

 

 

3. Задание на выполнение лабораторной работы 

 

Задание на выполнение лабораторной работы следует 
выбирать из таблицы 3 в соответствии с номером студента в списке 

группы. 

 
Таблица 1 Задания на выполнение лабораторной работы 

№ Задание 

1 Настроить нечеткий регулятор таким образом, чтобы 
уменьшить колебательность системы. Использовать 

единичное задающее воздействие. 

2 Настроить нечеткий регулятор таким образом, чтобы 
понизить время переходного процесса. Использовать 

единичное задающее воздействие. 

3 Настроить нечеткий регулятор таким образом, чтобы 
понизить перерегулирование. Использовать единичное 

задающее воздействие. 

4 Настроить нечеткий регулятор на отработку нарастающего 

задающего воздействия. 

5 Настроить нечеткий регулятор таким образом, чтобы 

уменьшить колебательность системы. Использовать 

задающее воздействие y = 20. 

6 Настроить нечеткий регулятор таким образом, чтобы 
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понизить время переходного процесса. Использовать 

задающее воздействие y = 20. 

7 Настроить нечеткий регулятор таким образом, чтобы 
понизить перерегулирование. Использовать задающее 

воздействие y = 20. 

8 Настроить нечеткий регулятор таким образом, чтобы 
устранить колебательность системы. Использовать задающее 

воздействие y = 30. 

9 Настроить нечеткий регулятор таким образом, чтобы 

понизить время переходного процесса. Использовать 
задающее воздействие y = 30. 

10 Настроить нечеткий регулятор таким образом, чтобы 

понизить перерегулирование. Использовать задающее 
воздействие y = 30. 

 

 

4. Оформление отчета о выполнении лабораторной работы 

 

Требования к отчету:  

 отчет содержит титульный лист, описание выполняемого 

задания, описание проделанной работы, анализ 
полученных результатов, выводы, список использованной 

литературы; 

 отчет выполняется на листах формата А4, 14 кегль, 
одинарный межстрочный интервал; 

 список литературы оформляется согласно ГОСТ 7.1-2003. 
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